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PART CREATION TUTORIALS
This section is intended to help you learn how to set up and create part geometry. As the variety and
arrangements of machines are so great, the tutorials in thismanual are created using special
trainingMDDs. TheseMDDs are incapable of posting but accurately represent a dual-spindle,
dual-turret machine and a swiss-style machine with 2 spindles, 2 turrets and a fixed post. Please
use theseMDDs as youmay find that theMDD for your machine has a very different setup and you
may not be able to complete the tutorials with it.

Please note that the background color and several elements of many of the graphics have been
modified for maximum image clarity.

Part Setup
In this exercise wewill introduce you to setting up a part. Wewill make a very simple part but will go
into detail on the various elements.

1. Create a new part file named Dual Spindle.

2. Open the Document Control dialog.

3. Select the Training Twin Turn [2T-2S]
MDD.

This is a basic two-turret, two-spindlemachine.

Do not worry if your MDD hasmore than two spindles and/or turrets. When programming a
part, you do not need to take advantage of all of your machine’s capabilities. In this case we
simply will not be needing all those axes.

If, however, your machine has one spindle, this particular exercise hasminimal benefit to you.
Machineswith a single spindle are very easy to set up inMTM. You should follow along in the
exercise and simply skip over what you cannot program.

Spindle Setup

1. Enter these parameters for Spindle 1.
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Wewill discuss these settings in detail. First of all, we are programming the part using a
diameter measurement. We have stated that there is Initial Stock, meaning this is the spindle
that will begin working from uncut stock. The Preloaded box is checked, meaning that the
machine has stock loaded. There will not have to be a command to load stock. Essentially we
are telling the program, “Don’t worry about it, trust me, there will be stock to cut, I will take care
of it myself.”

The stock diagram has a lot of important information, including that we are defining the stock on
Spindle 1, the stock is 2" in diameter and the part is 3.2" long. How dowe know this? Easy.
What is the total distance in Z? The –Z value is –3.1" and the +Z value is 0.1." Thus the total
length is 3.2."We have also specified that the face of the part sticks out from the spindle by 3.5."
Thismeanswe have 0.3" of bar stock sticking out of the spindle. Whenwe feed the bar for the
next run of the program, we feed out approximately 3.2", depending on the width of the cut off
tool.

While the setup shown abovemay at first appear to have the part floating in space away from
the spindle face, we should remember that these values set up the stock display size, not just
the actual stock size. These values have been set to contain the part and anymaterial to come
off the part face. The extra 0.3" could be added to the –Z value but is not necessary and inmany
cases is undesirable. It is undesirable because of the size of the stockwhen unzooming the part.

The Auto Clearance and Tool Change settings are not our primary concern right now aswe are
only concerned with setting up the part and not definingmachining parameters. Youmay either
leave the values at their default or enter the values shown above.

2. Click the Spindle selection button to change the Document dialog to setting up Spindle 2.

The DCD should display Spindle 2’s initial setup as being identical to Spindle 1’s. This is
convenient if you are cuttingmultiple parts at the same time on separate spindles. This will need
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to be changed to accurately reflect the part’s condition after being transferred from the primary
spindle.

3. Enter the parameters for Spindle 2 as shown.

Again, we should discuss these settings in detail. The Radius and Diameter radio buttons are still
available. You can still change this setting, but all spindles will be programmed using the same
measurement system.

For Spindle 2 we have stated that Initial Stock is off, meaning that there is no stock on this spindle
and at some point a transfer will bemade. Because there is no stock, the Preloaded box is not
needed.

When Initial Stock is turned off the stock diagram changes dramatically. The –Z and Xd text
boxes are removed because they are no longer needed. These settings are no longer needed
because we are only concerned with the amount that sticks out of the sub spindle from the pick
off. The values remaining are asking you to define how far the part sticks out from the spindle
and how much stock is on the positive side of the origin. This part of the part setup needs to be
carefully considered.

In this case, we have specified that 0.85" sticks out from the spindle. Our finished length part
geometry is exactly 3.0" long. Assuming that 0.1" gets faced off on Spindle 1 and 0.1" is
removed during the cut-off, we have a part that is 3.0" long. By specifying that the part sticks out
by 0.85" we are implying that the chuck is holding the rest of the part and the part is picked off at
Z–2.15". This information is important when setting up a part transfer.

Sometimeswhen setting up a part, youmaywish to change this setting during or after your
machining has been created.

The remaining data, Tool Change and Auto Clearancemay be skipped for the time being. As for
the Graphic Part Face Distance setting, we will get into that next.

4. Close the Document Dialog so you can see all of theWorkspace.
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Both spindles are visible. The default distance between the origins of the spindles is the scaled
distance in your MDD. This distance can be visually changed with the Graphic Part Face
Distance setting.

5. In the Document dialog, click the Graphic Part Face
Distance checkbox and enter the value shown.

Now that the spindles appear larger on screen you will have an easier time working with them.
This function acts only as a change in display. The actual distance between spindles is a fixed
value in your MDD and is defined by your machine.
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When a part is created, the system generates one or four coordinate systems for each spindle. If
you have Lathe andMulti-TaskMachining the system creates one coordinate system per
spindle, the ZX plane. Note that the depths of the CSs project out towards each other. The
negative depth of the ZX axis is always towards the spindle face.

If you haveMill/Turn andMulti-TaskMachining the system generates four Coordinate Systems
— the ZX, XY, HY backside and YZ planes. The XY, HY backside and YZ planes are shown in
the following set of graphics.
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XY HY Backside YZ

Geometry Creation and Arrangement

In this exercise wewill create geometry for the
"Dual Spindle.vnc " part created in Exercise 1,
and transfer it to the sub spindle. For those with
a single spindlemachine, this exercise can be
seen as a review of how to create andmodify
geometry.

The part we will make looks like this image. Do not worry if you do not have Advanced CS or
Mill/Turn functionality to complete themilling features of the part, because the exercises are
designed with this in mind.

1. For the part print, see “Main
Spindle” on page 121. Create
the geometry in CS1, the ZX
plane.

When using theMulti-TaskMachining product it is often convenient to have geometry on both
sides of the part’s centerline. This is particularly convenient when performing –X sidemachining.
While you can select geometry on the +X side, the toolpath will show up on the –X, thus it is good
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to have geometry to show the toolpath clearly. An example of this can be seen in themachining
tutorial section.

2. Select the geometry (Ctrl+A).

3. Modify> Duplicate and Mirror the geometry about the Xd at 0.

Wewill now copy the geometry to the sub spindle.

4. Select and duplicate all of the geometry (Ctrl+A, Ctrl+D).

Having the geometry for both sides of the part can be very helpful, especially when
creating operations that cut on the –X side of the part. Having geometry on both sides
of the center line allows you to actually set themachiningmarkers on the –X side in
addition to comparing toolpath against part geometry.

You now have two overlapping sets of geometry: the original, which is unselected and the
duplicated geometry.

5. Open the CS list .

6. Select the ZX plane as the target spindle from the
CS list.

Changing coordinate systems changes the color of the geometry in Spindle 1’s ZX plane.
Geometry that ismagenta (pink) is in a non-current coordinate system but is still in the same
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workgroup. This is shown underneath the selected geometry. The selected duplicate geometry
changes from red to green.

7. Choose Modify >CS> Change CS (HVD).

The Change CS (HVD) commandmoves and aligns currently selected geometry to the current
CS. The geometry is placed in the target CS at the same position relative to the target CS’s
origin, as the geometry was in the original CS. In other words, if the geometry is a point at Z-1,
X1 in CS1, it will be placed at Z-1, X1 in the target CS.

The duplicated geometry has now beenmoved to the ZX plane of the target spindle. It is still
selected and therefore highlighted in red.

The geometry ismirrored and now needs to be flipped to align the geometry correctly.

8. ChooseModify > Mirror andmirror the geometry about Z0.

This has flipped the geometry over so that it is facing the correct direction, as shown below (the
geometry is still selected). Wewill now translate the geometry into place.

9. ChooseModify > Translate.

Wewill now interrogate the Z value of a geometric element that is supposed to lie at Z0.

10. Interrogate the Z coordinate (Alt+click) the point shown.



Part Creation Tutorials

11

11. Change the interrogated value to a negative value.

12. Click the Do It button, and click away from the part to deselect it.

The transferred geometry is now aligned properly.

Sub Spindle Geometry

In this part of the exercise wewill modify the Dual Spindle.vnc part file to add on backside geometry.
In making thesemodificationswewill be working in a different coordinate system than youmay be
accustomed to. Despite this, you will find this no different to working in the standard ZX plane.

We need tomakemodifications to the part file. Wewill be defining the ID geometry as shown in the
cutaway view of the part below.
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We need tomodify the geometry that was duplicated andmoved to the sub spindle. We do not need
the part profile that is on the -X side of the sub spindle.

1. Switch to the HomeView (Ctrl+H).

The Home view changes the current view to be looking down the depth of the current CS. This
flips your view of the part so that the sub spindle is on the left and themain spindle is on the right.
Your view is now from the back of themachine.

2. Delete the geometry on the -X side of CS5: ZX plane - S2: Spindle 2.

3. For the part print for this exercise, see “Sub Spindle” on page 122. Create the geometry in CS5,
the ZX plane.

4. Duplicate andmirror the geometry about X0.

The geometry for the part is complete. Save the part as Dual Spindle.vnc.
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TOOLING TUTORIALS
This section of the tutorials show the creation and setup of tools for theMulti-TaskMachining
system. There are a total of three exercises. The first exercise is for a single spindle, dual turret
machine. The second exercise is for a dual-spindle, dual-turret machine. The last exercise is for a
Swiss-style machine.

The first two tutorials are created using the genericMulti-TaskMachiningMDD called Training Twin
Turn (2T-2S). It is recommended that you go through all of the tutorials, even if you do not have a
machine that matches the tutorial’s description. For theMachining tutorials, see “Multi-Task
Machining Tutorials” on page 41. Youmay either complete all of the tooling tutorials and then work
on themachining exercises or youmay do a tooling tutorial thenmove to the corresponding
machining exercise.

Basic Tool Setup
In this exercise you will be introduced to setting up tools for Multi-TaskMachining parts. First we will
create a part that ismachined on a single spindle, dual turret machine.Wewill start with a part file
that already has geometry. Wewill be creating six tools for OD and ID turning aswell asOD milling.
Once the tool creation is complete, we will machine the part, see “Single Spindle Part” on page 41.

1. Open the part file Single Spindle.vnc.

If you do not have the part file youmay create it using the geometry part print, see “Single
Spindle Part” on page 123.

Pay careful attention to the tool orientation
diagram and the Tool Group selection. If a tool
is pointing down it will be in the upper turret
and if it is pointing up, it will be in the lower
turret.

Upper Lower

2. Open the tool list.
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Tool Group 1

1. Double-click space #1 in the Tool list to create a new tool that will be used to face the part.

Face Tool

2. Create Turning Tool #1 as
shown.

The tool is assigned to Tool Group 1, is in the first position, and is aligned to the primary spindle. The
tool will be cutting on the +X side of the part and since the spindle runs counter-clockwise, the insert
is Face Down. The insert Orientation is set to use a horizontal toolholder and the insert is set to cut
down.

The tool diagram shows the insert on the backside of the tool holder because
the tool is face down.
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Face Drill Tool

1. CreateMilling Tool #2 as
shown.

This drill is set to drill the face of the part. The drill is in Position 2 of Turret 1 and aligned with
Spindle 1.

Wewill now create a tool that will be used for ID roughing and contouring.
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2. Create Turning Tool #3 as
shown.

This tool has a similar setup to Tool 1 but the insert is at the top of the holder.
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Tool Group 2

OD Roughing

1. Create Turning Tool #4 as
shown.

This tool will be used for OD roughing. This is the first tool we have defined
in Tool Group 2 and is in Position 1. The tool is set to cut from the –X side of
the spindle. Because the tool is cutting on the –X side, the Insert is Face Up.
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2. Create Turning Tool #5 as
shown.

This tool will be used in aMaterial OnlyOD Roughing operation.

This tool is in the second position of TG2. The setup is identical to Tool #4,
the tool is cutting on the –X side of the part and is Face Up.
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OD Groove and Finish

1. Create Turning Tool #6 as
shown.

This groove tool will be used to cut the grooves and finish the part. The tool is
set to cut from the bottom of the part but will cut from the back of the part. We
will now organize the Tool list.

2. Right-click any of the Tool tiles and choose Sort Tools.

The tools are sorted by Tool Group.
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3. Save the part. If you do not have theMill option, skip to the next exercise.
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Mill Turn Tools

OD Mill

1. CreateMilling Tool #8 as
shown.

This endmill will be used tomill a hex on theOD of the part from the +X side.

The next two tools will drill holes on theOD from the -X side in TG2.
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OD Drills

1. CreateMilling Tool #9 as
shown.
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2. CreateMilling Tool #10 as
shown.

3. Right-click a tool tile and choose Sort Tools again.

4. Save your part file.

For themachining tutorial for this part, see “Single Spindle Part” on page 41. Youmay either
continue on to the next tooling exercise or move on to themachining of this part.
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Dual Spindle Setup
In this exercise wewill set up the tools for cutting the dual-turret, dual spindle part earlier in the
tutorial. For details, see “Geometry Creation and Arrangement” on page 8. TheMDD (Machine
Definition Document) we are using is a dual-spindle, dual-turret machine. Turret 1 and 2may
access either spindle. Turret 1 is on the +X side of Spindle 1 while Turret 2 is on the –X side of
Spindle 1. The tooling wewill set up will have Tool Group 1 accessing only Spindle 1 and Tool
Group 2 will access both spindles. Wewill define both turning andmilling tools. Aswith previous
exercises, you do not need themilling option to do this exercise. Wewill define a total of 21 tools to
cut this part.

1. Open the part file Dual Spindle.vnc.

2. Open the Tool list.

The tools are created in the order of their accompanying operations, by Tool Group. This is done
strictly for convenience in this exercise and does not need to be true for other part files.

3. Create Turning Tool #1 as
shown.

This tool is Face Down in Position 1 of Tool Group 1. Aswith all tools in TG1, this tool cuts on the
+X side of the part. This tool will be used to face and rough theOD.



Tooling Tutorials

26

The tool and insert orientation as described above is similar to the image
above. The insert is Face Down, approaching from the top of the spindle.

4. Create Turning Tool #2 as
shown.
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5. Create Turning Tool #3 as
shown.

The tool is oriented to cut from the spindle towards the face of the part.

6. Create Turning Tool #4 as
shown.
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The arrangement of this tool is identical to tool #3.

7. CreateMilling Tool #5 as
shown.

Note that, for clarity, the correct orientation is circled.
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8. Create Turning Tool #6 as
shown.

This tool will rough the ID of the part.

9. Create Turning Tool #7 as
shown.
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This trigon will be used to finish the ID of the part. This tool’s arrangement is identical to tool #6.

10. Create Turning Tool #8 as
shown.

Wewill now create the tools contained in Tool Group 2.
Tool Group 2 approaches the part from the –X side.
Most of the tools will be set to cut on Spindle 2 but
several will access Spindle 1.
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11. Create Turning Tool #9 as
shown.

This tool will be the last tool used in the program.

This tool is being placed in Position 1 of TG2. Second, the tool is oriented to
Spindle 1. That means the Insert Orientation will be set in relation to Spindle 1,
not Spindle 2. Third, this tool is cutting from the –X side, as are all tools in Tool
Group 2. Lastly, note that this tool is designated as being Insert Face Up. Were this
tool being used on Spindle 2 this setting would be Face Down but Tool Group 2 is
moving to Spindle 1 for this operation, As the spindlemoves counter-clockwise
and the tool is below the spindle, the insert should be Face Up.
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12. Create tool #10 as
shown.

This tool will be used to rough theOD of the part once transferred to Spindle 2.

13. Create Turning Tool #11 as
shown.
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This will be used in anOD Threading operation. The alignment is identical to Tool #10.

14. Create Turning Tool #12 as
shown.

This tool will create the part’s OD grooves. The alignment is identical to Tool
#10.
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15. Create Turning Tool #13 as
shown.

This tool will be used for cutting the part’s ID grooves.

Perhaps you were wondering how a tool that is intended to be used on the ID can be defined with
the Insert Orientation diagram shown in the above image. And perhaps you noticed that the Insert
Orientation diagram and the overlapping graphic are different. The overlapping graphic shows how
the insert holder would look in reality. The Insert Orientation diagram simply is used to show how
the insert will be held, not how the holder is set.
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16. CreateMilling Tool #14 as
shown.

This drill will make a hole at the back of the part.

Spindle 1 is the Orientation Spindle for the tool. This drill will be cutting on Spindle 2, therefore the
Tool Orientation diagram is set to cut away fromSpindle 1, as shown in the image above.
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17. Create Turning Tool #15 as
shown.

This tool will be used to rough the ID.

18. Create Turning Tool #16 as
shown.
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This tool will be used to finish the ID.

If you do not haveMill capabilities, you have completed the tool creation for this part. Youmaymove
on to theMachining tutorials. If you do haveMachining capabilities wewill now define these tools.

19. CreateMilling Tool #17 as
shown.

This tool will be used to create the hex on the back of the part.

The next four tools are drills. The first two tools will be created in TG1, the others in TG2.
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20. CreateMilling Tool #18 as
shown.

Note that this tool is in TG1.

21. CreateMilling Tool #19 as
shown.
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Note that this tool is also in TG1.

22. CreateMilling Tool #20 as
shown.

Note that this tool is in TG2.
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23. CreateMilling Tool #21 as
shown.

Note that this tool is in TG2.

The tools for the Dual-Turret, Dual-Spindlemachine exercise are now complete. Save the file as
wewill be using it later.
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MULTI-TASK MACHINING TUTORIALS
This section of the tutorials will introduce you to generatingmachining operations inMulti-Task
Machining parts. There are three tutorials in this chapter with each increasing in complexity, starting
with a single-spindle part, progressing to a dual-spindle part and finishing with a swiss-style part.

The tutorials aremade using generic trainingMDDs (Training Twin Turn [2T-2S].mdd and Training
Swiss [1P2T-2S].mdd). As such, anyone can create these parts, even if you do not have amachine of
this type. It is recommended that you do all of the tutorials to maximize your familiarity with the
system. Please note that these trainingMDDsmay have options (particularly Utility operations) that
youmay not see when creating a part using your machine-specificMDD. This is typically because
your machine does not support this function. Also, these trainingMDDs are generic and do not
have a post processor; thus, they cannot produceG-code.

Single Spindle Part
In this exercise you will be introduced to creatingmachining operations for Multi-TaskMachining
parts. Wewill use the single-spindle, dual-turret part file created earlier in the tutorial, see “Basic
Tool Setup” on page 14. This exercise will help you become acclimated to working with multiple
flows and create simple operation synching. The exercise is designed for any user. You can
complete this part whether you have Lathe or Mill/Turn functionality. Users with the basic Lathe
package will complete the part shown below left. Once that is complete, users with Mill/Turn
functionality will further machine the part to create the drill holes and Hex head (below right).

Setting up the Operations

Front Face

1. Open the file Single Spindle.vnc.

This exercise does not use Auto Clearance. Auto Clearance is not used because of the relatively
small amount of clearance available for ID cutting. This is the only exercise that does not use
Auto Clearance.
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2. Open the Tool and CAM lists.

Wewill begin this tutorial by creating a facing operation followed by drilling and ID turning
operations. All of these operationswill bemadewith tools from Tool Group 1. To face off the
part we will need to add a line on which to set out machiningmarkers because the front face of
the part is an arc.

3. Create a vertical line at Z0.

It does not matter how you draw the line. For this example we used the axis line tool.

The length of the line is not important becausemachiningmarkers will specify the start and end
points of the operation.
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4. Create a Lathe Contour
Processwith the 0.4” 80°
Insert (Tool #1) as shown.

This creates a tile in the list that displays the tool number and Tool Group information.

1. Tool Group
2. Tool Group Position
3. Orientation Spindle

Note that the process states that it will be cutting on the +X side of the part.

4. Select the line you created for the contour.
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5. Set themachiningmarker as shown.

Drag the Start marker to a point above the stock and the Endmarker to
just below themiddle of the stock as shown in the image.

6. Create the toolpath to face the part.

Wewill now create a drilling operation to removematerial from the center of the part. After the
drilling operation wewill create ID roughing and contouring operations to finish the ID.

7. Deselect the operation.

8. Clear the process list.

ID

1. Create a Lathe Drilling
Processwith the 13mmDrill
(Tool #2) as shown.

The Tip Z value of -66mmwas determined by interrogating the Z depth of the ID.
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2. Create the drilling operation.

Wewill now create a Rough and Contour combination processwith the same tool.

3. For Process #1 create a
Lathe Rough Processwith
the 0.8” 80° Insert (Tool #3)
as shown.
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We use an Entry and Exit
Clearance value of 12.2mm
because that is theMinimum
Bore clearance required for
the boring bar we specified in
the tool definition.

The value of 10.5mm is determined by interrogating the same point from the previous process.
This depth ensureswewill clear out all of thematerial at the back of this hole.

4. For Process #2 create a
Lathe Contour Process
again with the 0.8” 80° Insert
(Tool #3) as shown.
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Wewill now set themachiningmarkers for the processes. The operation will extend from the arc
at the front of the part to the back of the ID.

5. Select the arc and set themachining
markers as shown.

The tool cuts on the outside of the
shape, heading towards the inside of
the part.

6. Create the Rough and Contour operations.

7. Render the operations.

As you can see, the basics of Multi-TaskMachining are the same as a standard lathe.Wewill
now create roughing and plunge roughing operations on theOD of the part from the –X side.

8. Deselect the operations and clear any existing Process list items.
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OD

1. Create a Lathe Rough
Processwith the 0.4” 80°
Insert (Tool #6) as shown.

Use tool #5 if you do not haveMill/Turn.

Note that the process is set to cut from the –X side of the part. This is because the tool we are
using is designated as cutting from the -X side. This value can be over-ridden, if desired, by
clicking on the Cut Other Side checkbox.

Other than the information that the process is cutting from the bottom of the part, the information
in this dialog is set up no differently than any other process dialog.We now need to set the
machiningmarkers for this operation.
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2. Set themarkers as shown.

Select the arc on the –X side of the front of the
part. Be sure that the end point marker goes all
the way to the back of the stock.

3. Create the toolpath.

We could have very easily set themachiningmarkers on the +X side as shown above left and
the same toolpath would be generated. It may bemore convenient to have themarkers in the
same place as the toolpath. There is no real difference, as shown, but if there were no geometry
on the –X- side of the part the toolpath could not be visually verified.

The Cut direction Axes restriction in the process dialog is not supposed tomake any –X moves
along the part yet it would seem that the toolpath does this. In fact, the toolpath does not make
any –X moves along the shape.

All of the toolpath is first generated from the +X side of the part and then “flipped” to the –X side
for graphical accuracy.

If you consider the axes as being arbitrary names, the turrets on the +X and –X side
each see the part from the same point of view. The turret on the bottom of the part is
potentially performing the samemoves that the turret on the top of the part would
make, except the bottom turret ismirrored. Therefore, it does not matter where the
toolpath is first generated. It is easier to always visualize the toolpath as first cutting on
the top of the part and then beingmoved, rather than always trying to remember
exactly which direction the tool is coming from and thinking around that. If you watch
the toolpath generation closely, youmay even see the toolpath being generated on the
+X side then getting flipped to the –X.

Wewill now continue generating toolpath on the –X side of the part by clearing out the recess not
cut in the previous operation.
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4. Create a Lathe Roughing
Processwith the 0.19”
Groove tool (Tool #7) as
shown.

Use tool #6 if you do not haveMill/Turn.
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5. Set themachiningmarkers as
shown.

Be sure that the end point marker goes all the way to the back of the stock.

6. Create the toolpath.

The next operation will use a groove tool to cut the grooves and finish the OD. This processwill
cut from the back of the part to the front.
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7. Create a Contour Process
with Groove Tool (tool #8) as
shown.

Use tool #6 if you do not haveMill/Turn.

8. Set themachiningmarkers as
shown.

Be sure that the end point marker is in themiddle of the arc at the front of the part.
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9. ClickDo It or (Alt+.) when you are
finished, to create the toolpath.

10. Render the operations.

Grouping Ops by Flow

Weare now going to organize this part better.

1. Click the Sort Operations option from the operations right-clickmenu.
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The operations in this list are now divided and sorted by flows.

The Operation Data dialog, also on the operation tile Right-clickmenu, allows you to
enter information about the operation that will appear in the post, set overrides to values and
lock values so other users cannot override your settings. Additionally, syncs are shown at the
bottom in the Utility Data section. We recommended that you do not change sync data the
system creates here.
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Control of Flows

Syncing Operations

1. Open the SyncControl dialog.

This SyncControl dialog displays all of the operations in the part. The
operations are sorted into flow columns. Each operation tiles length,
is an accurate representation of the time needed for the operation.
This is where wewill set syncs to control the operations in each flow.
Note the operation numbers highlighted in the screenshot.

If we look at the rendering, the start of the two flows is simultaneous. Even though there should
not be any interference among the turrets, we will put a sync in tomake theOD roughing
operation wait until the face contour operation is complete.

2. Ensure the syncmode is on.
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While in Syncmode each operation tile has two selections, the start and end of the operation.
To select the operation start, select the top of the tile. To select the operation end, select the
bottom of the tile.

3. Select the bottom (Op end) of Op1 in Flow 1.

4. Select the top (Op start) of Op6 in Flow 2.

5. Click the Operation Sync button.

Both flows are updated and Flow 2will now start onceOperation 1
has finished. The run-time of the part has also been updated. Setting
syncs is that easy.

Youmay notice that the run-time of Op 1 is different after the sync is set. Before the syncwas
set two flowswere cutting on the spindle at the same time — one flow was performing a facing
op and the other flow was performing anOD Rough, each using the Constant Surface Speed
setting. Since both operations cannot have control over the spindle speed at the same time, the
system gave Flow 2 the spindle control. By setting the sync, the run-time for Op 1 is
recalculated.
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Operation 1 now
completed, Operations
2 and 6 begin.

6. Save the part file.

If you do not have themilling option, you have completed this exercise andmaymove on to the
next tutorial, see “Dual Spindle Part” on page 66. If you do have themilling option, we will now
mill andOD drill this part. First we need to sort the tools to get themill tools into order.

7. Close the sync dialog.

If the dialog is left open somewarningsmay appear aswe addmore operations.Wewill fix
these sync errors at the end.
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Milling Ops

Hex Head

1. Switch toWorkgroup 2:Milling and CS4:
YZ plane.

All of the geometry for themill components of this part are contained inWorkgroup 2 and belong
to CS4: YZ plane. This includes a point at themiddle of the line at the bottom of the recess of the
part and a point and line that will be used tomill a hexagon near the back of the part.

The first milling operation wewill create will be tomill a hexagon by using six rotary positioned
contour cuts.

2. Create aMilling Contour Processwith the 13mmRough Endmill (Tool #4) as shown.



Multi-TaskMachining Tutorials

60

3. Select the horizontal
line.

4. Set themarkers as shown.

This will be a centerline cut from the +Y to the Y– side of the part. The tool should cut on-center
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5. Create the
toolpath.

Be sure you are not cutting from the Y– side. To cut down on the amount of movement by the
tool, experiment with the placement of themachiningmarkers to optimize the amount of feeding
required.

The next set of operationswill spot and drill three holes in the recess of the part.

6. For Process #1 create aMill Hole processwith the 7.5mmSpot Drill (Tool #9) as shown.
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7. For Process #2 create aMill
Hole processwith the 5mm
Drill (Tool #10) as shown.

The Full Diameter Z value is determined by interrogating the same point used for the ID drill
depth. There is no need to enter rotary positioning information for this process. Linked
processes have the same positioning information by default.
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8. Select the point
shown.

9. Create the toolpath.

Even though these drills are
approaching from the bottom
of the part, we can still use
geometry defined at the top of
the part. The post will simply
handle the position of the
spindle when the program is
run.

One thing that will not be handled by the post or themachine is twomilling operations occurring
on the same spindle at the same time.We need to sync the contouring and drilling operations.
Additionally, we have amilling operation happening concurrently with a turning operation.
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10. Open the SyncControl

dialog.

When the SyncControl dialog is opened we get warnings that there are conflicts with spindle
control. Wewill set a sync and fix the problem. First we will need to adjust the scaling control in
the sync dialog so that we havemore precise control over expanding/contracting the tile display.

11. Click the Eye symbol on the SyncControl Dialog. This opens the Sync Preferences
dialog.

12. Change the scale to 10%.

13. Now change the tiles to Uniform view and use the down arrow to fit the operations
into the sync control window.

You can drag the edge of the dialog to expand the Sync control dialog if necessary. It is also
possible to view the dialog horizontally - for this, select the Horizontal button in the Sync Preferences
dialog.
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14. Select the start of operation #9 and the end of operation #11.

15. Click the Operation Sync button.

16. Click the Uniform view button to switch it off, then click the Recalculate button.
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The operations have now been synced. Click the Error check button. It will now display All
Checks Passed.

17. Render the operations.

18. Be sure to save the part.

Dual Spindle Part
In this exercise wewill machine the Dual Spindle.vnc part created earlier in the tutorial, see
“Geometry Creation and Arrangement” on page 8. This tutorial will create a part using both turning
andmilling operations. Aswith other tutorial exercises, you do not need to have themilling option to
complete the exercise. In this tutorial we will have Turret 1 performmachining operations on the +X
side of Spindle 1 only. Turret 2 will primarily cut on Spindle 2 except for the part cut-off or if you are
performing themilling operations. Turret 2 is set up to cut on the –X side of the part. When complete,
the part will look like the following images.
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Part Setup - Tool Change

1. Open the part file Dual Spindle.vnc.

For details on the tooling for this exercise, see “Dual Spindle Setup” on page 25. If you have not
completed this exercise, please do so now.

We first need to check our Clearance and Tool Change settings. Wewill be using Auto Clearance
for this part. The tool change position for both spindles will be Z2" and Xd+/-10" from the origin.
The Xd value will depend on whether the turret is the Upper or Lower turret.

2. Enter the information in the
Document dialog as shown.
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3. Switch to Lower and enter the
settings shown in the Interop
Positions tab.

4. Switch to Spindle 2 and enter the information shown.

5. Open the Tool list andMachining palette.

6. Open the Part Stations list from the Commands Toolbar.

7. Hide Spindle 2.

8. Unzoom (Ctrl+U).

Themain spindle is now the only spindle in theWorkspace. Showing and hiding spindles will
make creating partsmuch easier.
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Setting up the Operations

Front Face

1. Create a Lathe Rough
Processwith the 1/64” 55°
Insert (Tool #1) as shown.
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2. Set themachiningmarkers as
shown.

3. Create the toolpath.

OD

Wewill now rough theOD of the part. To do this we will make four operations, two roughing and
two contour operations.
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1. Create a Lathe Rough
Processwith same insert
(Tool #1) as shown.



Multi-TaskMachining Tutorials

72

2. Set themachiningmarkers
as shown.

This will cut from the front to the back of the first groove.

3. Create the toolpath.

The next set of operationswill continue tomachine theOD of the part. Wewill rough and finish
the back side of the front flange with tools 3 and 4 in amulti-process operation, Perhaps you
recall that these tools were set to cut from the back of the part to the front.
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4. For Process #1 create a
Lathe Rough processwith
the second 1/64” 55° Insert
(Tool #3) as shown.
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5. For Process #2 create a
Lathe Contour processwith
the 1/64” 35° Insert (Tool #4)
as shown.

6. Set themachiningmarkers as
shown.

This will generate toolpath that will cut from themiddle of the part to the front of the flange.
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7. Create the toolpath.

The next operation wewill make use of the contouring operation that we just used.

8. Delete the Rough Process from the list.

9. Change the tool in the last
Contour process to the 1/64”
35° Insert (Tool #2).
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10. Set themachiningmarkers as
shown.

This will cut from the front of the part to the back of the first groove, as shown below.

11. Create the toolpath.

Note how the tool will rapid over the area that has been finished by operation #4.

12. Switch to the isometric view (Ctrl+I).

13. Render the operations.

Image 1 showsOperation #2 near the end of its last pass. Image 2 showsOperation #4, a
contouring operation, finishing the back of the flange. Image 3 showsOperation #5 performing a
Material Only Contouring operation to finish the OD and Image 4 shows the part condition after
the first five operations.
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ID

Our next set of operationswill be to Drill, Rough and Finish the ID of the part.

1. Create a Lathe Holes
processwith the 1/2” Drill
(Tool #5) as shown.



Multi-TaskMachining Tutorials

78

2. Create the toolpath.

This will drive the tip of the drill to the back of the part.

The next set of operationswill be amulti-process operation consisting of a Rough and a
Contour process.

3. Create a Lathe Roughing
processwith 1/64” 80° Insert
(Tool #6) as shown.

Be sure to enter a stock value for the Contouring operation to clean up.

4. Create a Contour processwith the 1/64” Triangle Insert (Tool #7) as shown.
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5. Set themachiningmarkers as shown.

6. Create the toolpath.
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7. Render the Operations.

OD Thread

The last turning operation wewill perform on Spindle 1 will be anOD thread at the front of the part.

1. Create a Lathe Thread processwith the Threading tool (Tool #8) as shown.
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2. Create the toolpath.
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3. Render the operations.

At this point we will create Utility operations to place the sub spindle on the part and return with
the part. While this can be created at any time, we will do this now so that we can render
operationswewill create on the sub spindle. While operations can be created on a spindle that
does not have stock, rendering will not show up if stock has not been transferred to the spindle.

Utility Ops

1. Double click a process tile and select the Utility function tile. A tool is not needed.
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The Utility process tile seen in the CAMpalette is a capital “U”. No tool is required so the “No
Tool” tool type should be selected.

Once “No Tool” is selected the icon in the process tile changes tomatch the type of Utility
operation being created. By default this is typically “Load Spindle” but depending on your MDD
may be something else.

The first Utility operation wewill make is Unload Spindle. Before bringing our sub spindle to the
main wewant to be sure the spindle is empty.

2. Create an Unload Spindle operation as shown.

3. Create a Sub Spindle In operation as shown.
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The Grip Z value specifies the depth at which the sub spindle will grab the part. The sub spindle
will grab the part 0.100" from the first groove. If you look at the Operations list you will see that
these Utility processes actually created two operation tiles each. This is for synching purposes;
the operations represent the start and end of the Sub Spindle On Part operation. Wewill now
generate twomore Utility Operations. The first will return the sub spindle to its normal position
and bring the cut off part with it, and the second operation will load stock into Spindle 1.

4. Create a Sub Spindle Return operation as shown.
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Be sure that theWith Part checkbox is checked.

5. Create the Utility operation shown.

Click Do it (Ctrl+.).
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Sub Spindle Ops
OD

Wewill now create the sub spindle operations.

A recommendedmethod for creating operations is to create all ops on the primary
spindle first. Once the operations are complete and valid, theymay be changed to the
sub spindle. This is an excellent method for new users as it minimizes the complexity of
the part.

All milling operationswill be created last. Wewill bemoving the operations performed on the sub
spindle to the empty tile slot so wemay leave the empty space.

1. Open the Spindles list and show Spindle 2.

2. Switch to CS 5: ZX plane of Spindle 2 and Unzoom.

3. Switch to the Home view (Ctrl+H).
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This will re-orient your view of the ZX plane of Spindle 2.

4. Create a Lathe Rough processwith the 1/64” 55° Insert (Tool #10) as shown.
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5. Set themachiningmarkers as shown.
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6. Create the toolpath.

The operation we just created will rough the backside of the part. Themachiningmarkers were
set on the bottom of the part for ease of visualizing what the tool will do. Remember that all tools
in Tool Group 2 are approaching from the bottom. The next operation wewill create will
machine theOD grooves.

7. Create a Lathe Contour processwith the Groove Tool (Tool #12) as shown.



Multi-TaskMachining Tutorials

90

8. Set themachiningmarkers as shown.

The groove tool simply dips into each of the grooves.

9. Create the toolpath.



Multi-TaskMachining Tutorials

91

Wewill next generate the ID machining, including drilling roughing and finishing operations.

ID

1. Create a Holes processwith the 3/4” Drill (Tool #14) as shown.

2. Create the toolpath.

The next set of operationswill be amulti-process operation consisting of a Rough and a
Contour process.

3. For Process #1 create a Lathe Rough processwith the 1/64” 80° Insert (Tool #15) as shown.
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4. For Process #2 using the same tool create a Contour process as shown.
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5. Set themachiningmarkers as shown.

6. Create the toolpath.
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7. Create a Contour processwith Groove Tool (Tool #13) as shown.

8. Set themachiningmarkers as shown.
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9. Create the toolpath.

OD Thread

The last turning operation we need to create is the OD thread on the sub spindle.

1. Create a Lathe Thread Processwith the Thread Tool (Tool #11) as shown.
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2. Create the toolpath.
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3. Save the part file.

This completes the turning operations on this part.

Hexagon

Wewill now create several milling operations. The first operation wewill create is the hexagon on
the backside of the part. To generate this operation wewill need to create some geometry.

1. Switch to CS8, the YZ Plane of Spindle 2.

2. Create a horizontal line at Z: -0.5", X: 0.75".

3. Create aMill Contour processwith the 0.5” Finish Endmill (Tool #17) as shown. Note the CS
used in the Rotate tab.
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4. Set themachiningmarkers as shown. This placement is crucial - note the positioning of the
white and blackmarkers.

5. Create the toolpath.



Multi-TaskMachining Tutorials

99

6. Render the operations.

Drilling ops TG1

Wewill now create drilling operations on Spindle 1 with tools in both Tool Groups. To perform these
operations youmust have the Advanced CS option.Wewill be creating a new CS to drill on the B-
axis of this part.
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1. Create a new CS based on CS4, the YZ plane of Spindle 1.

2. Switch to Spindle 1.

3. Select the point shown and click the Change CS Origin button.

4. Create a horizontal line at Z0.

This line will be used to help align the CS.

5. Select the two lines shown
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6. Click the Align CS Plane button.

Wewill now rotate the CS 180° around its depth axis.

7. Deselect all geometry and click the Align CS Plane button again.

This will open the CS Align dialog.

8. Rotate the CS as shown.



Multi-TaskMachining Tutorials

102

9. Rename the CS “B-Axis Drilling”.

We now need to create a point for the drilling operationswewill be creating.

10. Create aMid-Point for the line shown.

11. For Process #1, create aMilling Holes Processwith the 0.35” Drill (Tool #18) as shown.
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12. For Process #2, create a Holes processwith the 0.2” Drill (Tool #19) as shown.
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13. Select themid-point and create the toolpath.
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Drilling Ops TG2

Wewill now create drilling operations for Tool Group 2 using the processes from Tool Group 1.

1. Change the tool used in Process #1 to tool #20, the 0.05” Drill andmodify the Process as
shown.
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2. Change Process #2 to use the Tap tool (Tool #21) andmodify the Process as shown.
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3. Deselect the previous operations.

4. Create the toolpath.

We now need to sync the drilling operations because otherwise wewill have twomilling
operations trying to perform tasks on the same spindle at the same time. Additionally, we need
tomove the operations into the flows, meaning the operations need to be placed within the
bounds of the utility operations.

5. Drag the opswith tools 18 and 19 to the space betweenOps 9 and 10.
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This will put the operations before the Utility operations begin.

Sub-Spindle Utility Ops

1. Create an Unload Spindle operation as shown.

2. Create a Sub Spindle In operation as shown.
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3. Create a Sub Spindle Return operation as shown.

Be sure that theWith Part checkbox is checked.

4. Create the Utility operation shown.
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Click Do it (Ctrl+.).

Cut Off
That completes the turning operations on the sub spindle. We now need to cut off the part.

1. Create a Lathe Contour processwith the Cut Off tool (Tool #9) as shown.
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2. Set themachiningmarkers as shown.

This will cut the back of the part.

3. Create the toolpath.
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Wewill re-order the operationswe have just created because we have created a sequence of
operations that cuts off the part before the sub spindle actually grips it.

4. Drag the cutoff operation betweenOp #27 andOp #28.

5. Open the SyncControl dialog.
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An error message appears that says there is a spindle control conflict at Op 8. That is because
we currently have turning andmilling operations happening on Spindle 1 at the same time.
Whenwemoved the last two Holes operationswe inadvertently caused this potential conflict.

To fix this we will sync the drilling operations.Wewill have the Tool Group 2 drill and tap wait for
the Tool Group 1 tools to finish. That will fix the conflict and put our drilling operations in order.

6. Switch to the uniform view.

This will allow you to select timeline scale so that you can see the operations at the end of both
flows.

7. Select the Op end (bottom half) of Operation 11 and theOp Start (top half) of Operation 26.

8. Click the Operation Sync button.
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The TG2 drilling opswill now wait for the TG1 to finish.

9. Render the operations.
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10. Save the part.

Auto-Flip

This exercise is intended to familiarize you with
modifying tool information to automatically flip
toolpath across X0. Some people findMTM to be
easier or more familiar by setting up the part as if it
were a regular lathe part, and thenmodify the
operations. The exercise uses a pre-made part
called Auto-Flip.vnc (For the part print for this
exercise, see“Auto-Flip” on page 124). Wewill
modify three of the tools to flip the existing toolpath
from the +X side to the –X side.

Wewill modify the last three tools to flip the OD Plunge rough at the back of the part, the OD Thread
and ID Contour operations. After we have flipped the operations, we will sync them.

Looking closely at the last three tools in the list (tools 5, 6 and 7), you can see that each of the tools
is in Tool Group 1. These tool positions also conflict other tools. Since these tools are not on amini-
gang of some sort, we have simply used these numbers for convenience since wewill be changing
the Tool Group these tools are assigned to.
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Flipping Tool directions

Upper to Lower

1. View the toolpath for Op #5.

We are simply loading it so you can see the “before and after” results.



Multi-TaskMachining Tutorials

117

2. Modify tool #5 as
shown.

3. Choose View > Redraw to redraw
the toolpath. (Ctrl+R).

The toolpath is automatically updated to cut on the –X side.

Next we will update tool number 6 and 7.

4. Select Op #6 andOp #7.
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5. Choose View > Redraw.
(Ctrl+R)

You can see that both operations cut on the +X side of the part.

6. Modify the TG, cut side and insert settings of tool #6 and tool #7.

Make sure you choose Insert Face Up setting.

Tool #6 Tool #7

7. Redraw the workspace.

You can see that the toolpath is automatically updated to cut from the –X side.

We now need to add two syncs to the part. The first will makeOperation 6 start after Operation
2.



Multi-TaskMachining Tutorials

119

Syncing the new flow

1. Open the Sync dialog and click the Uniform Tile button.

2. Create a sync at the end of Op #2 and the start of Op #6.

The next syncwill cause the ID Contour to wait for the drilling to finish.

3. Create a sync at the end of Op #4 and the start of Op
#7.

Now that we have our syncs set we should check the run-time. Since we have different Tool
Groups trying to control the spindle’s RPMat the same time, we should specify which
operations have control over the spindle speed.

4. Turn off UniformView.

5. Switch to the SpindleMode.
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The highlighted operations currently have
control over the spindle. Wewill now give
Operations 1, 2, 4 and 6 control over the spindle
speeds.

6. (Ctrl+click) Ops 1, 2, 4 and 6 and deselect any other Ops.

7. Recalculate the run-time.

The run-time should now take a little over fiveminutes.

8. Render the new operations.
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PART PRINTS

Main Spindle
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Sub Spindle
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Single Spindle Part
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Auto-Flip
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